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Abstract

Project Code:  RDG5140024 

Project Title:  The implementation of DSSARM-TKR 1.0 in flooded-prone areas of 
Paw river, Kalasin province 

Activity Title:  Developing the decision support system “DSSARM-PAW for agricultural 
development in flooded-prone areas of Kalasin province” 

Investigators:  Analaya Nansaior 1, Piyanoot Sirimungmool 1

1 Faculty of Technology, Khon Kaen University 

E-mail Address:  rusamee@kku.ac.th 

Project Duration:  1 May 2008 – 30 April 2010

This activity is developed of the decision support system “DSSARM-PAW for 
agricultural development in flooded-prone areas of Kalasin province”. The “DSSARM-
PAW” had data and various information or content that is updated. Creating new structures, 
collecting and developing are done in the same format. Special characteristic, that is user 
friendly and meet the needs of users. In addition, users can also work and input new more 
information. They can be also use this system to analyze as a tool to assist in planning, 
decision making and set some project to identify target area or target groups. The 
“DSSARM-PAW” has the geo-database, and socio-economic data. Both of secondary which 
is collected from other organization and primary data that collected and published in various 
sub-projects under The implementation of DSSARM-TKR 1.0 in flooded-prone areas of Paw 
river, Kalasin province. DSSARM-PAW workshop is set for exchange, learning how to use 
for further application. 

Keyword : data, database system, decision support system
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5�/��� ���	
'�%� .�����
��������*�!$/���������.��� �����
��-�����"%���� 
�'��!����#����������,,�	�� - �����/)���� �� 2 ���:�� �'��!���*��?!�����*'����,���%��

��������*��� 2 ��/�������%�����+�� (+'���0���'��!�+'�����?�4 �'��!�,�9��
���
�1�� �'��!�
���41/���� ����
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�'�#�������� ��,,�	��-�����/)���� �)�
�'��'��!�������!��,, ��*�0��
+���������
�)�
�'�#��
�����������,,	��,���*�+	��#% �	��. 1.0 ��������������
����#��� @8��31����
�&���,,
����������
�&��������*'��,, ���(+'��,���	��,	��������%��%��	)�������������	��,	�������)�
��%�� (	��.) #�,���/�������38��'��!����	����3,��%�#���,, �	��-�����/)���� 
1��'��!�#����:���$�
��� ����'��!����3!�%�+
�",#����:��	
��+��	 #�������� excel 

5�/������
�4��.2��#$ 

��)#���
����?��5�/���
%�&�
������������.��� �
��-�����"%���� 

���#�'���������� �	�� ��/�*������%�
�&����
*������/��'��!�	)����,�)�(��	+�#�
������� @8��#���/�*����/*'�����$!'
*�����'��!������
����!'���
���
�'�#%#����,�������

����6
���+'�� GIS 4�	�
�� 
�1���%��*'�����
�
��
#������

����6 	)����,���	�'�� ������,���� ������

4���
*�������
���+����'��!��+�#�'

�1���%�����������

����6��� GIS #�*�������
��/���/
�1��#�'��+
������� ARCGIS ��� ESRI 
�&�����#�����)���� �+�����������������	)�
�9
1� ArcMap ��� 
ArcCatalog #�
��	����/
�&�
4���*�������	)����,��/�*���������)�0���'��!�
41���)�
�'�(��	+�#�
������� �	�� 
4���,����/��'��!�
�����/� @8��$!'�)��'��!����*'�������/��'��!��1��2 ���
��1�%����/	����3
%��)���������/(����,#�'#����%�+����'��!��1��2 (+'*��(� 

��/�*������2 #����%�+����'��!��,��(+'
�&� 5 ��/�*��+����/ 
1. ������,�����'��!�������%�+����'��!�
,1/��*'� 

2. �����

����6
���@'����, (Identity) 
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3. ���	�'���!��,,����	+��'��!� (Style) 

4. ���	�'��0���'��!�	��	�
�� (Geodatabase) 

5. ����)��'��!�
�'�	!�������� �	�� 

1. �����
�����5�/���.��	
'���5�/���*�!"/���� 

1.1 ������������� : ArcMap 


��+������� ArcMap �+�(���� Taskbar 
�1�� start > All Programs > ArcGIS > ArcMap 

��1�
�1��(�
��  
41��
��+������� 
�1��
��+�������%�4,��'�*�������������+��;���#$ 1.1 

 

;���#$ 1.1 �	+���'�*���������� ArcMap 



�

�


�1�� A new empty map ��'��+ OK +��;���#$ 1.2 

 
;���#$ 1.2 �	+���/�*��������,�����'��!�
,1/��*'� 

��� Menu ������,�+'��@'�� ��'�
�1�� File > Add Data +��;���#$ 1.3 

 

;���#$ 1.3 �	+���/�*��������,�����'��!�
,1/��*'� 



�

�


�1��(G�6���*'�����
4����'��!���'��+ Add +��;���#$ 1.4  

 
;���#$ 1.4 �	+���/�*��������,�����'��!�
,1/��*'� 

 

#���������'��!����(��������)���+ (define) ��,,4���+
���*)������ (projection) %�����I��'�*���
�����+����/ @8���+����*���/��'��!����
�&� GIS %�*'������,,4���+��,�(�'
	�� �����(��"*����/��'��!����

�1�����
�
��+
41���)����(+' ��'���(������,,4���+�"*�� �+�
�1�� OK  +��;���#$ 1.5 

 
;���#$ 1.5 �	+���'�*���������(��������)���+��,,4���+ 



�

�


�1���+ Ok �'��!����
�1��%�3!��	+������+��;���#$ 1.6 

 
;���#$ 1.6 ?�4�	+��$�������
�1��(�' 
1� ��,
�*�����
�����+�,*)�,� 
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1.2 ������	�������������������
� (XY Coordinate System): ArcCatalog 

1.
��+������� ArcCatalog �+�(���� Taskbar 
�1�� start > All Programs > ArcGIS > ArcCatalog 

+��;���#$ 1.7 

 

;���#$ 1.7 �	+���/�*��#����
��+������� ArcCatalog 



�
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2.
�1�� Connect to Folder %���3,

�1����1�+'��,�
41��
����*)���������%�+
�",�'��!�#�
��4��
*��6
�����#�'��� 

 

3.
�1�� Folder ���
�", Shapefile (�' +��;���#$ 1.7 ��'��+ OK ����I��'�%�+��;���#$ 1.8 

 
;���#$ 1.7 �	+����
�1��(G�6���*'����� 

 



�

�

 
;���#$ 1.8 �	+���'�*����'��!����(+'
�1�� 


��������� Shapefile �1�� tambon �������+'����� ��'�
�1�� properties +��;���#$ 1.9 

 
;���#$ 1.9 �	+���/�*������)���+��,,4���+ 
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(�����3, XY Coordinate System ��'��+ Select +��;���#$ 1.10 

 
;���#$ 1.10 �	+���/�*������)���+��,,4���+ 


�1�� Project Coordinate Systems +��;���#$ 1.11 %����/�
�1�� UTM >> WGS 1984 

%�4,��'�*���+��;���#$ 1.12 

 
;���#$ 1.11 �	+���/�*������)���+��,,4���+ 



�

�

 
;���#$ 1.12 �	+���/�*������)���+��,,4���+ 


�1�� WGS 1984 UTM Zone 48N.prj ��'��+ Add +��;���#$ 1.13 

 
;���#$ 1.13 �	+���/�*������)���+��,,4���+ 



�
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�1�����,�������'�*���
+��%�(+'$�+��?�4��'��+ OK +��;���#$ 1.14 

 
;���#$ 1.14 �	+���'�*������3!��)���+��,,4���+
	�"%	�,!��6 

���,������'��*'�#�'	)����,�)���+ Shapefile �1��2 (+'*��*'����� ��1�$!'#�'���	�����3�)���+4���+
�����/��'��!��1��2 +'����<���� Import 
��4���+%����/��'��!����(+'�)�����)���+
��4���+(�������'� @8��
��<������/%�	����3�)�#�'$!'�)��'��!�������+
���#�����)��'��!�#�'	�/���(+' 
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1.3 �������� Field ����������!�������"����#"������������
�������: ArcMap 

1. 
��+ ArcMap ��'��)����
4�����/��'��!����*'����� 
��� TAMBON.shp 

2. 
��������� TAMBON  
�1�� Open Attribute Table +��;���#$ 1.15 

 

;���#$ 1.15 �	+���/�*�����
��+*���������/��'��!� 

*���������
���+�����/��'��!�+�������%�3!��	+������+��;���#$ 1.16 

 

;���#$ 1.16 �	+������
���+�'��!�#�*���� 
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3. %��*������/ 
�1�� Options > Add Field +��;���#$ 1.17 

 

;���#$ 1.17 �	+���/�*�����
4���
�����6 

#�����*���������/*'�����
4���
�����6
41��,���1�����*)�,� %8��)��+�����)���+�1�����
�����6 ( 
Name) , �!��,,����'��!� (Type) , ������+�������	)����,,��%�*�����:��)���+#� Field 

Properties +��;���#$ 1.18 ��'��+ OK  Field #���%�����I#�*����+��;���#$ 1.19 

 

;���#$ 1.18 �	+���'�*�������)���+�1��
�����6 



�
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;���#$ 1.19 �	+�*�������3!�
4���
�����6 (Field) 
���,�'�� 

&���*&��: Field ���*'�����	)����,��/��'��!���,
�*�����
���#��*�����+�,���$!'%�+����'��!�
%)�
�&�*'��	�'���8/�
41���)�(�#�'#�������� �	�� ��+����/ @8���+���*�$!'�)��'��!�%�*'���)���/� 3 ��/��'��!�
#�'��'�
	�"%������/�*���1��2  

�
"�5�/�����'
��%��� 

5. Name = TAM_Code, Type = Text, Data = Length 6 

6. Name = TAM_Name, Type = Text, Data = Length 100 

3. Name = AMP_Code, Type = Text, Data = Length 4 

4. Name = AMP_Name, Type = Text, Data = Length 100 

1. Name = PRV_Code, Type = Text, Data = Length 2 

2. Name = PRV_Name, Type = Text, Data = Length 100 

7. Name = AdminName, Type = Text, Data = Length 200 

8. Name = DataSource, Type = Text, Data = Length 200 

 



�

�

�
"�5�/�����'
�/%�*;/ 

3. Name = AMP_Code, Type = Text, Data = Length 4 

4. Name = AMP_Name, Type = Text, Data = Length 100 

1. Name = PRV_Code, Type = Text, Data = Length 2 

2. Name = PRV_Name, Type = Text, Data = Length 100 

7. Name = AdminName, Type = Text, Data = Length 200 

8. Name = DataSource, Type = Text, Data = Length 200 

�
"�5�/�����'
�	
�&�
' 

1. Name = PRV_Code, Type = Text, Data = Length 2 

2. Name = PRV_Name, Type = Text, Data = Length 100 

7. Name = AdminName, Type = Text, Data = Length 200 

8. Name = DataSource, Type = Text, Data = Length 200 

�

1.4 ��� calculate $
�%� Field: ArcMap 

#�����)���+�����
���+����'��!�#��*��� Field �+�����(�����!�	�������� 
1� 1.
�+����'��!��������!�

+�� ��� 2.4��46�����
���+�+�$!'#�'���
�� @8����������� 1 �)�(+'�+����
��������� Field ���*'�����
4���
�'��!� #�*���������/
1� TAM_NAME ��'��)����
�1��
)�	��� Field Calculator +��;���#$ 1.20 

 
;���#$ 1.20 ?�4�	+���/�*����� calculate 
��#� Field 
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#�*���������/ *'������)��1��*)�,��������!���'� �+���!�#� TAM_NAM_T ��
�&��'��!���� TAM_NAME ���
	�'���8/���#��� +����/� �)����
�1�� ��'��+ OK +��;���#$ 1.21 %�(+'$���4<6�	+�+��;���#$ 1.22 

 

;���#$ 1.21 �	+���/�*����� calculate 
��#� Field 

 

;���#$ 1.22 �	+���'�*���$���4<6������ calculate 
��#� Field 
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	������������ 2 
1����4��46�����
���+�+�$!'#�'���
�� �+��)����
����������1��
�����6���*'�����
4���
�����
���+
�'�(� �+���*���������/�*��+��;���#$ 1.23 

 

;���#$ 1.23 �	+���/�*����� calculate 
��#� Field �+���<����4��46�����
���+%��$!'#�'���
�� 

#���������	)����,#	��'��!�#�'4��46�����
���+�+�#�' “ “ 
��,�'�
��� (#��������
�&�*��
��(��
%)�
�&�*'���� “ “ ) #�*���������/
�&����
4��������
���+������������'��!� �+�4��46 “�!��6�'��!� %.
��;	��<�6” ��'��+ OK +��;���#$ 1.24 $���4<6(+'+��;���#$ 1.25 

 

;���#$ 1.24 �	+���/�*����� calculate 
��#� Field �+���<����4��46�����
���+%��$!'#�'���
�� 
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;���#$ 1.25 �	+�$���4<6������ calculate 
��#� Field �+���<����4��46�����
���+%��$!'#�'���
�� 

1.5 ��� �� Field �#!&�
�������: ArcMap 


��������� Field ���*'������, ��'�
�1�� Delete Field +��;���#$ 1.26 

 

;���#$ 1.26 �	+���/�*������, Field ���(��*'����� 



�

�

�+ OK 
41���1����+��;���#$ 1.27 

 

;���#$ 1.27 �	+���/�*������, Field ���(��*'����� 

#���/�*����/���+�'��*'� 
�&�*���������������'(�������,�'��!�#�'*��*��
���*'����� @8��
�&�
���,������+�����(� $!'#�'���	����3�)�(����,#�'��,�'��!����+�1��2 ���%)�
�&�*'��#�'#�����	+�$� 
�����/�*�������

����6��/��'��!�*��(� 

2. �����*����&�*���@�/��
�'�����)# Identity 

�+�����2 (� ��/��'��!�����)���#�'�+�	���#�9����%�
�&���/��'��!�����������
���+
74�������/�
�'��!���/�2 
4���
�����/�
41���<�,��38�
������������/��'��!�+������� �*�	)����,������� �	�� ��

���%)�
�&���������������/��'��!������/�����)�
�'�%�*'���������
���+��� ���	*)�,� ���	�)�
?� ������	
%�����+ 
�&�	�����8�����*�������3�<�,����!�+'�� 
41��#�'
�&�*����9�% (Key) #����
����#�'�$����
	)����,����	+��'��!�+'��������� +����/� ��/�*�������

����6
���@'����,���������/��'��!��1��2 ��, 
��/��'��!���,
�*�����
��� %8���
���	)�
�9�������� @8��
�
��
��� GIS �������#�'#������

����6#�
�!��,,��/������������<���� 
��� ���������� (Union) ���@'����, (Intersect) ��1������,�
�����
���+�'��!� (Identity) @8���*�����<�����������
���+���$���4<6����*�*���������(� ���
�1��#�'
%8��8/���!���,
���*'��������$!'�)��'��!����*'�����
�"��'��!�
�&��,,#+ (�8�:�
4���
*��#��������
��1�
���������� ArcMap) #�*�������
��/���/%�#�'��<���� Identity 
41���)����
4���
*���������	+���
���+
��� ���	*)�,� �1��*)�,� ���	�)�
?� �1���)�
?� ���	%�����+ ����1��%�����+ #�'��,��/��'��!�*)������
��!�,'�������
4��������
���+����1����!�,'��������	��!�,'�� �����J��!�
�����/� �����
���+�����,
�*
�����
���%�#�'�'��!�%����/��'��!���,
�*�����
�����+�,*)�,����(+'	�'���8/�������'� �+�����/�*��
+��*��(���/ 



�

�


�1����/��'��!� ��!�,'�� (Village) ��� ��,
�*�����
�����+�,*)�,� (TAMBON) �	+�#� ArcMap 

($!'#�'�����%�)����
��+*�������3�<�,��#�'�	+�
41��*��%	�,�'��!�+��;���#$ 1.28)  

 

;���#$ 1.28 �	+��$�������*����
41��*��%	�,�'��!������/��'��!� 
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#��3,
��!#�'
������  
41��#�'������������

�1����1� (Tools box) �	+�+��;���#$ 1.29 

 

������ 1.29 �������	
�	��	
����������
������� 

#������ Analysis Tools �)����
������
41����
)�	��� Identity +��;���#$ 1.30 

 

;���#$ 1.30 �	+������
���+#������ Analysis Tools 
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���	��
��/� ��'�*���

�1����1�%�����I+��;���#$ 1.31 

 

;���#$ 1.31 �	+���/�*��#���� Identity �'��!� 

#�*)������ (1) Input Features 
1���/��'��!����*'�����
4���
*���'��!������,
�*�����
��� #������/
1�
��/��'��!���!�,'�� 

#�*)������ (2) Identity Features 
1���/��'��!����#�'#����
4����'��!�#�' Input #������/
1� ��,
�**)�,� 

#�*)������ (3) Output Features Class 
�&�*)����������1�����$���4<6%�����@'����, 


�1���)���+
��#�*)��������/���+
	�"%��'� #�'�+ OK %����/�%��8/���'�*���#�����)����
41���	+�#�'

�"���/�*���������)���������������������+
%�+��;���#$ 1.32 

1

2

3
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;���#$ 1.32 �	+���/�*������)�������������� 

$���4<6���(+'����I+��;���#$ 1.33 �+�����/��'��!���!�,'�����3!�@'����,����I�8/� ���
�1���	+�*����
���3�<�,�������/��'��!�+�������%�4,���
�&�*)��������!�,'������������
���+���*)�,� �)�
?� ���
%�����+,��%���!�*��
���*'����� +���	+�#����,	��+�#�;���#$ 1.33 

 

;���#$ 1.33 �	+���'�*��������/��'��!����3!� Identity 
	�"%	�,!��6 



�

�

��/�*��+�������
�&���/�*��	)����,���@'����,#���/��'��!�
+��� @8����/��'��!��1��2 %)�
�&�*'��
$������,�������/+'��
������ %8�%�	����3�)�(��	+�#��������(+' +����/�$!'�)��'��!�%)�
�&�*'���8�:�
��<����@'����,�'��!����
���%)�
�&�����'��!����*'������	+�
4���
*�� 

����%��$�����/�*�����������,������'(��'��!�#�'��
���	�,!��6���
4���
*�������
���+���
%)�
�&�
	�"%	�/���'� 
41��
�&�����)� Shap file #�'4�'��	)����,����)����@8��*'���)�#�'��!�#��!��,,���
0���'��!�	��	�
�� (Geodatabase) #���/�*��*��%����/(�%8�
�&���/�*�����	�'�� Geodatabase 


41��#�'	����3#�'���(+'��, ������� �	�� +'��������� ArcCatalog 

3. ���
�������.�����.
'�5�/��� (Style): ArcMap 

#�������� �	�� ��	��������,���	)�
�9��������#�����	+��'��!� 
������� Style @8��$!'�)�
�'��!���
���%)�
�&�*'���)����	�'�� Style �����/��'��!��������%�
�'�	!����,������)�
�'���/��'��!�#�
������� �	�� �+�����/�*��+����/ 

1. 
��+������� ArcMap ��'� Add data 
1� Village_Identity.shp %����/�
��+*�����<�,�����
�'��!�
41���)����
4��� Filed ����'��!� +��;���#$ 1.34 

 

;���#$ 1.34 �	+���/�*�����	�'�� Style �����/��'��!� 



�

�

�)����
4���
�����6�+� Add Field ��'��)���+�1����� Style ��� Type 
�&�*�����:� (Text) ���+
���
��'�����
�����6
�����, 50 +��;���#$ 1.35 

 

;���#$ 1.35 �	+���/�*�����	�'�� Style �����/��'��!� 


�1��(+' Filed ����1����� “Style” #�*���������
���+�'��!� �)����#	������
���+����'��!�#�
�����6 
“*)��������!�,'��” +��;���#$ 1.36 $���4<6���(+'�����+��;���#$ 1.37 

 

;���#$ 1.36 �	+���/�*�����	�'�� Style �����/��'��!� 

1

2

3
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;���#$ 1.37 �	+���/�*�����	�'�� Style �����/��'��!� 

%����/��)����	�'���!��,,����	+�����'��!��+����
�����������/��'��!� (1) ���
�1���	+� 
Properties (2) +��;���#$ 1.38 

 

;���#$ 1.38 �	+���/�*�����	�'�� Style ����'��!� 

1

2
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#���'�*������

�1����1�����)���+���:�� (Symbology) (1) 
�1����� Categories > Unique Values 

(2) %����/�#����� Value Field #�'
�1�� Style (3) @8��
�&� Filed ���	�'����/�������'�	)����,����)���+ 
Style �+�
74�� ��'�
�1�� Add Values (4) 
41��#�'
����� Filed ����I ��'�
���	��
��/����	�9���:�6
��������
���+�'��!� (5) +��;���#$ 1.39 

 

;���#$ 1.39 �	+���/�*�����	�'�� Style �����/��'��!� 

��'�*����������)���+�!��,,	�9���:�6�������)���+�!��,,	������/��'��!�����I#�'$!'#�'���

�1��#�'���+��;���#$ 1.40  

1

2
3

4

5
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;���#$ 1.40 ��'�*����������)���+�!��,,	�9���:�6�������)���+�!��,,	� 


�1���)���+
	�"%#�'
�1�� OK ��'�%�����������%��	+�	�9���:�6���	����(+'�)���+(�' +��;���#$ 1.41 

 

;���#$ 1.41 ?�4�	+�	�9���:�6���	����(+'�)���+(�' 
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�1��$!'�)��'��!���
���4�#%#��!��,,����)���+��'� ��/�*��*��(�
�&���/�*���������)��!��,,+�������
(�#�'���#�������� �	�� �+�����/�*��*��(���/ +��;���#$ 1.42(�)-;���#$ 1.42 (�) 
 

�3,

�1����1� 
�1�� Tools > Styles > Export Maps Style +��;���#$ 1.42(�) 

 

 

;���#$ 1.42(�) �	+���/�*���������)��!��,,(�#�'���#�������� �	�� 

�������%�#�'*�/��1������)���+�����!���� Style ���	�����(� �+ Save 

 

;���#$ 1.42 (5) �	+���/�*���������)��!��,,(�#�'���#�������� �	�� 

$���4<6������	����� Style 
41�������#�'��� ����I+��?�4��� �+�(G�6���(+'����	��� .Style 
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;���#$ 1.42 (�) ?�4�	+�$���4<6�����/�*������)��!��,,(�#�'���#�������� �	�� 

4. ���
����?��5�/���
��
�*�1 (Geodatabase) 

Geodatabase 
�&��!��,,���0���'��!����
�",��,����'��!���� GIS @8��
�&��'��!����
�����,+'�������!��,,�'��!� (+'��� �!�
��������+ (Polygon) 
	'� (Line) %�+ (Point) *�����'��!�
�<�,�� (Table) ����'��!�
������+ (Raster) @8����
����*�*�������������� �*������(��"*��0���'��!� 
Geodatabase 	����3�)����
���	�+��#����%�+
�",
41��#�'#������

����6�������(+'�+����� ��<����
	�'�� Geodatabase ����/�*��+����/ 

4.1 �������� Geodatabase: ArcMap 


��+������� ArcCatalog �8/�����'�
�1�������'�*�����/��'��!����+'��@'�� 
�&� Folder ���
�",��/��'��!�
���*'�����#�' +��;���#$ 1.43 
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;���#$ 1.43 �	+���/�*�����	�'�� Geodatabase 

#��������������	�'��0���'��!�#��!��,,��/%�#�'���
�+
�&��)�+�,��/� +����/ 

Geodatabase (0���'��!�	��	�
��) 

 Feature Dataset (����������/��'��!�) 

  Feature Class (Point, Line, Polygon, Raster) (���
?�������+�����/��'��!�) 

 Tables (*���������
���+) 

����3,

�1����1�
�1�� File > New > Personal Geodatabase ��1�
������*��*)������ Folder ���
*'�����	�'�� 
�1�� new ���
�1�� Personal Geodatabase +��;���#$ 1.44 
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;���#$ 1.44 �	+���/�*�����	�'�� Geodatabase 


�1��	�'��0���'��!�#��� �������%����9�*#�'�)���+�1��*����*3����	�
6 #������/*'�����	�'��
0���'��!�����1����� BaseMap (+'$���4<6+��;���#$ 1.45 

 

;���#$ 1.45 �	+���/�*�����	�'�� Geodatabase 



�

�

���	�'��0���'��!�*��
���%)�
�&�*'���)�
�&��)�+�,��/� +����/�
�1��	�'�� Geodatabase ��'�
	�"%#�

�)�+�,*��(�
�&����	�'�� Feature dataset �+�
���������     ��'�
�1�� new > Feature 

Dataset +��;���#$ 1.46(�) %����/��)���+�1�� (Name) #�'
�&� BaseMap ��'��+ Next +��;���#$ 1.46
(5) 

 

;���#$ 1.46(�) �	+���/�*�����	�'�� Geodatabase 

 

;���#$ 1.46(�) �	+���/�*�����	�'�� Geodatabase 
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%�����I��'�*���#�'�)���+��,,4���+��� Feature dataset �+�#�'�������#�����)���+
���
+������
��,�����,���,,4���+��� Shape file #���/�*��������'���/ @8��	����3�)�(+' 2 ��<� 
1� 

�) 
�1����,,4���+���*'����� �+����
�1�� Projected Coordinate Systems > UTM > WGS 1984 > 

WGS 1984 UTM Zone 48N ��'��+ Next +��;���#$ 1.47 

 

                 

;���#$ 1.47 �	+���/�*�����	�'�� Geodatabase �+���<����
�1����,,4���+���*'����� 

�) ��,��+�#�'��,,4���+��� Shape file ���(+'�)������,�(���'�#���/�*����� �����'�*��� 
�1�� Import 


�1�� TAMBON.shp ��'��+ Add #���/�*����/(+' Feature dataset �������,,4���+��,�
�&� WGS84 

UTM Zone48N �+ Next +��;���#$ 1.48(�) %����/��+ Finish +��;���#$ 1.48(5) 
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;���#$ 1.48(�) 

 

;���#$ 1.48(�) 
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��/�*��*��(�
�&����	�'�� Feature Class 	)����,��/��'��!� ����/�*��+��;���#$ 1.49(�)-;���#$ 1.49
(�)�+����
��������� feature dataset �1�� BaseMap ���	�'���8/�������'� ��'�
�1�� New > Feature 

Class +��;���#$ 1.49(�) 

 

;���#$ 1.49(�) �	+���/�*�����	�'�� Feature Class 	)����,��/��'��!� 

#�*���������/*'�����	�'����/��'��!� “�%�.&���&�������” 
41��#�'��� %8��)�����)���+���� Name 
�&� 
Village ����)���+ Alias (�1������	)����,����	+�) 
�&� *)��������!�,'�� ����)���+ Type 
�&� 
Point Features +��;���#$ 1.49 (5) 



�

�

 

+��;���#$ 1.49 (5)�	+���/�*�����	�'�� Feature Class 	)����,��/��'��!� 

�)����
�1��(G�6*)��������!�,'�����*'����� 

 

+��;���#$ 1.49 (�)�	+���/�*�����	�'�� Feature Class 	)����,��/��'��!� 



�

�

(+'�
��	�'�����0���'��!����
�&�*�������*����,�'��!����*)��������!�,'�� %����/��+ Finish 

 

+��;���#$ 1.49 (�)�	+���/�*�����	�'�� Feature Class 	)����,��/��'��!� 
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4.2 ���'�����
�������: ArcMap 


�1��	�'�� Feature Class 
	�"%��'� #���/�*��������'�%�
�&��
�������/��'��!��������
���� %)�
�&�*'��
�)�����)�
�'��'��!�	!��
��	�'��+������� #�������� ArcCatalog 
�&���/�*����� Load 
41��	�'��
�&���/�
�'��!����*'����� �+�����/�*��+��;���#$ 1.50(�)-;���#$ 1.50(	) 


��������� Feature Class ���*'��������+ #������/
1� Village ���	�'��(�'������'� +��;���#$ 1.50(�) 

 

;���#$ 1.50(�) �	+���/�*��������+��/��'��!� 

 
 



�

�

%����/�
�1���'��!����*'��������+#����� Input data +��;���#$ 1.51 

 

;���#$ 1.50(5) �	+���/�*��������+��/��'��!� 


�1���'��!��+�
������  ��'�
�1�� Shape file ���*'����� ��'��+ Add 
41��,��%���/��'��!����*'�����
���+
�'�	!����,����� ��'��+ Next +��;���#$ 1.50(�) 

 

;���#$ 1.50(�) �	+���/�*��������+��/��'��!� 



�

�

���
�&���/��'��!����
+���������
��	�'�����
��1����� �������%��)���� Match field �+���*����*� +��
;���#$ 1.50(�)  �+ Next 

 

;���#$ 1.50(�) �	+���/�*��������+��/��'��!� 


�1�� Load all of the source data %����/��+
�1�� Finish +��;���#$ 1.50(	) 

              

;���#$ 1.50(	) �	+���/�*��������+��/��'��!� 
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#���'�*����	+��'��!����������� ArcCatalog 	����3�	+���/��'��!�����)�������+(�
���,�'��(+'+��
;���#$ 1.51 @8/�#���/�*����/���+ 	����3�)�(����,#�'��,��/��'��!��1��2 (+'+'��
������ 

 

;���#$ 1.51 �	+�?�4��/��'��!�����)�������+(�
���,�'�� 
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5. ����%�5�/���*5��
�����.��� �
�� 
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������'� 	����3�)�
�'�	!��������(+'�+�����/�*��+����/ 
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��!�������/��'��!� (1) #������1����/��'��!� #�'�)���+
�&� *)��������!�,'�� (2) 
�1��0���'��!� 
Geodatabase ���	�'��(�' (3) ���
�1�� Feature Class ����1����� Village (4) 
�1�� Field Value 
�&� 
VILL_NAME (5) ��'�
�1�� *��(� (6) 
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�1�����,�������#�'	����3
����#�'(+'*��G��+6��,
�*����
+����/ ��,
�*%�����+ 
�1���+'�� ���	%�����+ ��,
�*�)�
?� 
�1�����, ���	�)�
?� ���*)�,�
�1�����,���	
*)�,� +��;���#$ 1.56 �+*��(� 
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